OL aVLYVEUTEC CWHATIOLWY OTO
CERN

...KOIL LOWC LEPLKEC TILOaVEC LOEEC YL TOUC LaONTEC
ofole



Tt vopdw ott ewval amapattnto va culntnBeL mptv amo omowadnmnote elocaywyn oto CERN,
TOUG ETUTAXUVTEC KOL TOUG QVLXVEUTEG.

(Amtapattnta) Bepoto mov €aPTWVTOL QO TNV NALKLA TwV LadnTtwv

e Jtouela Zwpatidtakns Quotkng (upnvikn, ATOMLKN)-EVOL TO AVTLKELLLEVO UOG

*  BOOLKEG YVWOELG NAEKTPOUAYVNTIOUOU-ELVOL O LOVOC TPOTIOC VA KATAAQBOUE TOV EMLTA-
XUVTN KOl TOUC QLVLXVEUTEC

* Boaolkeg SuvaATOTNTEC KATOVONONG HOONUATIKWY TUTIWV-ELVAL N YAWOOO OAWV TWV EMLOTNHUWV
Kol Hetpnoewv (aBeBatotnta Kot ocpaApo LETPNONC)-AAEC YPOAPLKEC TIOPOCTAUOELG

[EVLKEC YVWOELC yLoL OAEC TLC NALKLEG

TLewal n emotnun; Natt elval To6o oNUOVTILKO HEPOC TNG {wNnG KOG

Znuaota ylo tnv erlwon pog exouv Sladopeg EMLOTNUES AANQ N TILO ONUOVTLKN EXEL VO KAVEL
He Ttnv opBn mepypadng tnv puong.

TL ewval pla emotnpovikn Bewpta; TLonpatvel «amodedelypevn» entotnpovikn Bewpta; Tt
ONUOLVEL amoppLyn EMLOTNUOVLIKNG Bewplag; TL onuaoLa EXEL N LETPNON O€ OAQL AUTA;
TLewal n petpnon; TL ewval To oPpOaAUO OE YLOL LETPNON;

Mia emoTnpovikn Bewpla ywvetal Sektn e Baon LETPNOLUEG TTOCOTNTEC TO HeEYEBOQ

TWV OTIOLWV TIPETIEL VAL TIPOPBAETIEL KL VO EENYEL * OL LETPNOELG AUTECG OITOTEAOUV TUNHA TNG
arodoxng n tng aropptPng tng Bswplac.

Yav cuvolo Ba eAeya otL xpetlovtal ~10 wpeg oulntnong aAla KoL LEPLKEC EPYOACLEC YLOL VAL
Etowpaotel pia emioken oto CERN virtual n kavovikn.




Ta cwpatidla mov GUYKPOTOUV TNV UAN Ta PAETOUME TELPAOTLKA YLOTL SEV UTTOPOULE VO T
OOUUE HUE TO «HATIN-KAAO TTAPASELYHO TO LKPOOKOTILO.

Ta Payvou e TELPOPATLKA YLOTL EXOULE LA N TIEPLOCOTEPEG BEWPLEG TTIOU pag Ta
nepypadouv.

Ayn wotopla ya to CERN-€KTOG Qo g XpOVOAOYLEC TIOU UITOPELTE vVa BpeLte omoudnmoTte
(A.x. https://timeline.web.cern.ch/timelines/The-history-of-CERN) €xetL peyaAn onuoola va
TOVLIoOUE TL ewval kot ntav to CERN yla tnv Eupwrin tou 1950-yiwa tnv emotnun thg Evpwnng
KoL yla tTnv cupdtAtwon tn¢ Eupwnng tou 19?0( TIPETEL ETILONC vaL Tovioou e otL to CERN

MPOOTIAOEL VOl YIVEL TO LOLO KEVTPO avartuéng AWV CUVEPYOOLWY O€ TIOLYKOOLO Tl
emunedo. Na napadelypa To Sesame, cuyxpoTPo mnyn Gwtog
(https://home.cern/about/updates/2017 /98#¥ioneering-sesame-light-source-officially-

opened). Enmong ot xwpeg-peAn tou CER KOlL N TTPOEAEVON TWV avOpwmnwVv Tov
douAeuouv edw.



https://timeline.web.cern.ch/timelines/The-history-of-CERN
https://home.cern/about/updates/2017/05/pioneering-sesame-light-source-officially-opened

State members are: Austria, Belgium, Bulgaria, the Czech Republic, Denmark,
Finland, France, Germany, Greece, Hungary, Israel, Italy, the Netherlands, Norway,
Poland, Portugal, the Slovak Republic, Spain, Sweden, Switzerland, the United
Kingdom and Romania.

Serbia, Cyprus and Slovenia are associate members in the pre-stage to
membership, and Turkey, Pakistan, Ukraine and India are associate members.

Observer states and organizations currently involved in CERN programmes include
the European Commission, Japan, the Russian Federation, UNESCO and the USA.

Non-member states with co-operation agreements with CERN include Albania,
Algeria, Argentina, Armenia, Australia, Azerbaijan, Bangladesh, Belarus, Bolivia,
Brazil, Canada, Chile, China, Colombia, Costa Rica, Croatia, Ecuador, Egypt, Estonia,
Former Yugoslav Republic of Macedonia (FYROM), Georgia, Iceland, Iran, Jordan,
Korea, Lithuania, Malta, Mexico, Mongolia, Montenegro, Morocco, New Zealand,
Peru, Saudi Arabia, South Africa, United Arab Emirates and Vietnam.

CERN also has scientific contacts with Cuba, Ghana, Ireland, Latvia, Lebanon,
Madagascar, Malaysia, Mozambique, Palestinian Authority, Philippines, Qatar,
Rwanda, Singapore, Sri Lanka, Taiwan, Thailand, Tunisia, Uzbekistan.



Distribution of All CERN Users by Nationality on 20 January 2017

MEMBER STATES

7714

Austria 109

Belgium 125

Bulgaria 9%

Czech Republic 231

Denmark 67

Finland 114

France 367

Germany 1300

Greece 229

Hungary 81

Israc] 60 -

Italy 2027 .
Netherfands 170 ‘
Norway 62 |
Poland 322 ~

Portugal 18 b ~
Romania 128 by S
Slovakia 123 N\ a
Spain 438

Sweden 91

Switzerdand 228

United Kingdom 734 OBSERVERS 2666

Japan 327
v AAKS Russia 1141
ASSOCIATE MEMBERS USA 1198

336 676

India

Pakistan 67 OTHERS 1803 Bosnia & Herzegovina Ecuador 4 Kazakhstan | Mauritius 2 6 Taiwan 54
Turkey 173 Brazil 123 Egyp 31 Kemya 3 Mexico 82 Philippines 3 Thailand 23
Ukraine 100 Albania 4 Burundi 1 El Salvador I Korea Rep. 172 Mongolia 2 San Marino I TEY.ROM. 2

Algeria 13 Cameroon | Estonia 13 Kyrgyzstan I Montenegro 4 Saudi Arabia I Tunisia 6

Argentina 21 Canada 152 Georgia 47 Latvia 2 Morocco I8 Senegal 2 Uruguay 1
ASSOCIATE 70 Armenia 25 Chile 21 leeland S Lebanon 17 Nepal 9 Singapore 6 Uzbekistan 4
MEMBERS IN Australia 32 China 439 Indonesia 12 Lithuania 32 New Zealand 6 Sint Maarten 1 Venczuela 10
THE PRE-STAGE Azerbaijan 9 Colombia 43 Iman 59 Luxembourg | Nigena 3 Slovenia 31 Viet Nam I
TO MEMBERSHIP Bangladesh 11 Costa Rica 2 Ing I Madagascar 2 Oman 3 SouthAfrica 39 Zambia 1
Cyprus 25 Belarus 46  Croatia 41 Treland 16 Malaysia 19 Palestine (O.T). 7 Sri Lanka 3 Zimbabwe 4
Serbia 45 Bolivia 4 Cuba Jordan 2 Malta 10 Paraguay 1 Syria I

2xsbov oAot!




H 100 ToU OTL 0 KOGHOC YUPW HOC QTTOTEAELTOL OTTO ULKPOTEPO cwHATLOLA ELVOLL TTOAU

TIOALOL KOLL EXEL ATTOKPUOTAAAWBEL Kol emIBeBatlwOBeL meEpAUATIKA TOV TEAEUTALO ALWVAL.

Ta teAevtal 50 xpovia EXEL KATAOKEUAOTEL UE CUVEPYAOLOL OLVOLLECO OTLC OewpNnTIKEC UTTOBEDELG
KOl TLC EPYOLOTNPLAKEC LETPNOELG eva «ovteAAo» (standard model-kaBiepwpevo mpotumo) mou
TepLypadeL TOAAQ KOUUATLO TOU KOOLLOU TIOU MOG TIEPLKAELEL, pa oXL oAa. ot val LEAETNOOUUE OE
BaBoc¢ Ta MPOoTELVOUEVA TIPOTUTIOL TOU KOOUOU HOG TIPETTEL N VAL SNULOUPYNOCOUUE TTIOAAL
ocwpatidla mov Ba peletnooupe ylao va SOUE av oL LOLOTNTEG TOUC ELVOL QLUTEC TTOU TIPOPAETIEL TO
LLOVTEAAO OGN VOL BPOUPE pLa TtNYN OCWHOTOWWY

MPWTOC KAl LOVLLOG TIOPOYWYOG
CWHOTLOLWY EVOL TO CUUTAV OTTOU
oL SN (umtepkatvodavelg

aoTePEG!) ElvalL LOXUPEG

TINYEG KOOULKWYV oKTVWV 6nAadn
owpatdlwyv pe GopTLo TTIOU

8 umawvouv otnv atpoodalpa ...

O aAAOC TPOTIOC ELVOLL VO TIOPALYOU LLE
LOVOL aC Ta cwatdLa mou
LEAETOLE..QUTO KOVOUUE LLE TOUG
ETUTAXUVTEG.




TLumopeL va p.O(eEL EVOLQ uaenrnq OTTO JLAL Tt pouoLaon EMLITAXUVTWV
Attohoyla dnuoupylacg Kat e€eAénc Tng texvoloylac — N LOEA TOU «CTIOUE» TIPOYHLATA VLA VOl

doupe armo tL anoteAouvtal, N WOea Tng SNULoupyLag pLag otaBepng KoL EAEYXOLLEVNC TTNYNG
OCWHATLOLWV TTOU Hag EMITPETOUV va «EekAelbwaooupe» tn dopn tng UANG dwvovtag ota
CWHLOTLOL TTOU EVOL KPUHLEVA QLPKETN EVEPYELA YLa VoL «AUBouV» Kall va «uTtapEouv» eAeuBepal.
HAekpopayvnTiko eSS0 — NAEKTPOUOYVATIKA KU LATO-NAEKTPOUAYVNTLOUOG

W

 '\

- 4

{
't

Kow\otnteg padloocuyvotntwv

Ot KOLAOTNTEC PASLOCUXVOTNTWV ELVALL
ooV METAAALKOL KOUTLOL TTOU EUTIEPLEXOUV
geva nAektpopayvntko nedlo. OL
KOLAOTNTEG HOLa{OUV OOV XOVTPEG
KOUTTOAOYLOU TTOU TOV POAO TNG KAWOTNG
nialel n Seopn Twv GOPTICUEVWY
ocwpatidlwyv. OL KOLAOTNTEC EXOUV TO
KataAAnAo oxnua kot peye0og outwg
woTe T0o HM Kupa va CUVTOVLOTEL KOl va
EVIOXUBEL N EvepyELA TOU HECA OTNV
kKothotnta. Ta ¢popPTIoUEVA CWHATLA TTOU
TLEPVOUV LECQ ATIO TLG KOLAOTNTEG
dexovtal tnv petadopa EVEPYELAG KOl
ETILTAYUVOVTAL SLAPKWE KAL TIEPLOCOTEPO



Taxvtnta pwtoc, nAektpiko edlo, payvntko edlo, (e€lowoelg Maxwell), uttep-
aywyldotnta.

https://cds.cern.ch/journal/CERNBulletin/2015/32/News%20Articles/2038160?In=en

La supraconductivité

Dans les isolants, la résistance électrique

(- © °° est extrémement élevée. Les électrons sont
°° Py solidaires des atomes et ne peuvent étre
© ™ libérés pour créer un courant électrique.
ISOLANT

Dans les conducteurs, la résistance électrique
est faible, certains électrons sont libres et & o>
laissent passer un courant électrique lorsqu’on 9‘3’/, o
applique une tension. La résistance est une
mesure de I'énergie perdue sous forme de
chaleur, suite aux collisions entre électrons. CONDUCTEUR

" SUPRACONDUCTEUR

Lorsqu’un matériel devient supraconducteur,
@—» toute résistance électrique disparait. Les
électrons progressant par paires, il n'y a plus
de collisions entre les électrons. Le courant
circule alors sans perte d’énergie.

CERN AC _C508_V9/9/1997



O eruitayuvtecg oto CERN: avamapayouv o€ XWPO

TNV popdn mou €LXe N VAN eval SLOEKATOLLLUPLOCTO TOU Sec
LeTa To Big Bang-oL aviyveuteg tnv pwtoypadlouvv!

—  ——

LHC 0.999999998C(1
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s "~ 0.999998C 450 GeV LHCb
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e w neutrinos
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; Ps 0.993C 24GeV -
(
Leir -
—h

» p(proton]) » ion P neutrons » p(antiproton] ——— proton/antiproton conversion » neutrinos  » electron

LHC Large Hadron Collider SPS Super Proton Synchrotron  PS  Proton Synchrotron

AD Antiproton Decelerator CTF3 Clic Test Facility CNGS Cern Neutrinos to Gran Sasso  ISOLDE Isotope Separator OnLine DEvice
LEIR LowEnergylon Ring LINAC LINear ACcelerator n-ToF Neutrons Time Of Flight
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CMS Experiment at the LHC, CERN
Data recorded: 2015-Jun-03 08:48:32.279552 GMT

Run / Event / LS: 246908 / 77874559 / 86
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OLQVLXVEUTEG-KAUEPESG
*ELval ol « LNXOLVEGY TIOU pnotp.onmouus yla va Bpoupe Vlt 0
KOOMOG HOLG ELVOLL ETOL.

* Mot ta cwpatidia exouv dradopetikec polec

* TL €0l N GKOTELVN UAN GTO GUMTTAV
* Eav Loxuouv ot dtadopeg BswplLeC IOV AITOTELPWVTOL VO

ocuunAnpwoouv/avtikataotnoouv to “standard model”

* Mw¢ nTav n KwtTn, MUKvn rpwtn popdn tng UANG KAaopato Tou
deutepoAenttou peta thv MeyaAn Ekpnén

§ * Eav oL Bewpleg evomoinceLg popouv va enainbeutouv
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Ol AVLXVEVUTEC-KOMEPEC ELVOLLKOTIWE ETOL...
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CMS Experiment at LHC, CERN
'Data Recorded: Sat Apr 24 08:31:20 2010 CEST
| Lumi section: 795

Run / Event : 133874 / 64064942




ol aVvaeUte.Q;deepieq KaAo'p.Luér-pa.%

| HAe KTPOOLYVATLKO!

Adupn yevveon, akTivoBoALa nebnoswg

. okebaloN KTA-N apXLKN EVEPYELA TOU

Y - OWHOTISOU «peTadpaleTol» @€ dwTovla
! | Ko NAgKTpOvLal TOU, «dpwtoypadovtaLy

«Bapu UALkO»

/




YO aviyveuteg-kapepeg KaAo'p.Luét-'pa.

Abpavika
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A6p'OVL1§o'KouqutL KogtaLwVLciw HXéKt;)ouotvvnuKo
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% Ouaviyveuteg-Bolopot pHloviwy

3D view,

CMS Experiment at LHC, CERN
Data recorded: Fri Sep 24 02:29:58 2010 CEST
Run/Event: 146511 / 504867308




WIRE CHAMBER

THE FILM RECORDING THE PASSAGE OF A PARTICLE

Cathode plane

lonisation of the gas
by the passage of the
A electrically charged
particles.

Anode wires

lon migration:

(*)Towards the cathodes
(- Towards the anodes

Multiplication effect:
Electron avalanches
near the anode.

CERN AC _Z45



% Ouaviyveuteg-Bakapiol poviwy

CMS CMS Experiment at the LHC, CERN
Data recorded: 2015-Oct-30 19:23:54.631552 GMT
Ru 260424 / 211873064 / 115
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Ot cuyyxpovol peyadot aviyveuteg oto CERN: dwtoypadllouv

LE LEYAAN XPOVO-XWPLKN aKPLBELA TNV CUMTEPLPOPA TNG UANG
OTLC OUVONKEC apeowc peta To Big Bang (“apeowc “ <102 sec)

* OL OVLYVEUTEC EWVOLL TIPOYLOTLKAL LLEYAAOL....

Ovopa Bapog (tn) | MeyeBog (z,r) | ApXiko kKooto¢ | AvBpwrot
(MCHF)

ALICE 10000 26,16 ~300 ~1500

ATLAS 7000 44,22 ~550 ~3000

CMS 13000 21,16 ~550 ~3700

LHCb 4500 20, 5+ ~300 ~800

...ylatt mpenel va «pwtoypaploouv» TOAU «pIKpo» aviikepeva (< 1071 sec),
MIAQLULE YLOL OLTTOOTOLOELG ULKPOUETPOU Kal Xpovous {wng ¢paypata Tov psec.

O {ntoupeveg pwrtoypadreg ewvat tou pnoloviov Higgs, UMEPOUUHUETPLKWV
ocwpaTOLWVY, mini powpeg TpUnEeC, Baputovia n aAleg popdeg tng VARG (quark —
gluon plasma...)
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CMS ~13000 t

EM Kalopuetpo
YREPAYWYLHO GWANVOELSEC PIETP

ECAL
Scintillating Adpoviko Kaloplpetp

PbWO4 crystals Plastic scintillator/brass
sandwich

«Zuyog» alénpeu

15m

Tpo)xtoypadioc

Silicon Microstrips
Pixels

Total weight : 13,000 t ..
Overall diameter : 15 m
Overall length : 21.6 m
Magnetic field : 4(3.8) Tesla

OaAauotl poviwy

Drift Tube Resistive Plate Cathode Strip Chambers and
Chambers Chambers Resistive Plate Chambers
22 m



OL 4 «peyalow» aviyveutec tou LHC:

Exouv oloL ta LdLa tepUTou Koppatia (UTTAVIXVEUTEG). ...

Ymavixveuing ALICE ATLAS CMS LHCb
Vertex v V \4 V
detector/Tracker

KaAopluetpo V v v v
Muon detector |V V v v
Awadopa L \4 v NRRNNY

OAot gxouv evav kataypadea tpoxlwv (Tracker ota EAAnvika!) yia va «BAemouv» tnv
SdLadpopn Twv POPTLOUEVWY CWHATIOLWY OTO XWPO

OAol exouv gva kaloplpetpo (HAekTpopayvnTiko kat AGPOoVIKO) yLa va LETPOUV TNV
EVEPYELQ

OAOL £XOUV QVLXVEUTEC MLOVIWV-YLATL TO plovia Sev «TteBalvouv» ota KOAOPLUETPA KAl
N AVLXVEUGHN TOUG ELVOL TIOAU ONHOVTLKN
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ATLAS

~7'000 t

Muon Detectors Electromagnetic Calorimeters

. Forward Calorimeters
Solenoid
[
- End Cap Toroid
= | e =

J
Barrel Toroid Inner Detector Shielding

Hadronic Calorimeters

44 m

22 m



~4°500 t
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Mo «peta»y tov CMS

I | | | | | | |
Om m Im Im 4m Sm am m
Select:
Muon
Electron
— Hadron (e.g.Pion) :
----- Photon

Silican

Tracker

Electramagnetic

I }':1‘.]' Calorimeter

Hadron Superconducting

M, W2

Calorimeter Solenoid

Iran return yoke interspersad

Transverse slice with Muon chambers
through CMS 1

1, Rarney, €
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H ENIANOTH KAI KATATPADH TQN “rETONOTQN”

ATLAS
OL aviXveUTEG ewval axpnota akpBa rayvidia AL AS TDAG Global Architecture
XWPLG TO CUOTNUA ETUAOYNG YEYOVOTWY _— — —
(trigger) kaw tTnVv emthoyn Kat kotaypadn e
bdebopevwv (DAQ). Edw ta MHz kaw ta PB ewvat [ ]

KaOnuepwvotnta ya ta rteputov 100
ekatoppupla “kavaiia” mou “Stapalouv” Tig
TIANPOPOPLEG TIOU TIPOEPXOVTOL ATTO TLG
OUYKPOUGELG L]

| Eventbuilding |

CMS o
O
o
40 MHz Level 1 H Detector Front-Ends
Trigger T T T
¢ —'—H Readout
| - jl]‘r ;II]TFS
Event ) Control
5 Builder Network 100 GB/s and
L Menagn M Monitor z
< I I I l I Filter
_I_"—|_ Systems
2
10° Hz Computing Services




AMa kat (prawvw oto Ogpa...):

Lo TOV aVLYVEUTN ...

*2uotnpata HAektpkng tpododociac (~15-20kA, LOXUG, CUVEXEC Kol EVAAQGOOEVO)
eZuotnpata aeplwv (evdAekta Kat pun )

*Juotnpata Puktkwv( ~ -30°C kataypadeac TpoxLwy)

eTuotnpata eEunvwyv povwtwyv( ~ -20°C kataypadeag tpoxtwv ~ +17°C ECAL)
°ZUOTNUATO EAEYXOU KLVIOEWV OVTLKELLEVWV (UTIOOVLXVEUTEG Kol OANQL KOJLOTLOL
“Tuylouv” 2 kai 3 Tovwoug, aaOntnPeg)

euotnuata eheyyou nmepiBaiiovroc (Eepoc aepac, alwto)

oyuotnuata evbuypapionc (laser) kat eAeyxouv kwvnoswv (CCD kapepec)
*ZUOTNATA LETPNOEWC Kal oXtL Hovo, Tn¢ padievepyelag (dtadopetikec pebodol)

Mo o tepLBAAAOV YUPW OUTTO TOV AVIXVEUTN

*ZUOTNHATA OEPLOMOU TOU TIELPOMATLKOU Xwpou (+/- 2°C)
*Zuotnpata eAeyxou nepiBaiiovrog (Vypaotia, Oeppokpacia)
eJuotnpata PukTtkwv (~ 159C)

*Zuotnpata eubuypapiong (laser)

*ZUOTNUATA KLVNONG TWV KOMUATLWY Tou avixveutn (ouvoAwka 13!)

la tov Mayvntn

eZuoTtnpata eAeyxou nepBailovtog
eJuotnpata PUKTkwv(-268°K)

*Zuotnpata Kevou (povwan)

*2uotnpata HAektpkng tpododociac (18-20kA)




* 0O oxeblaopoc, mpooopowwon, kataokeun, enBefawwon, Babuovopnon €vog aviyveutn
LLE aKPLBELA LETPNONG EVEPYELEC KOl LKAVOTNTA KaTaypadng TOANATTAWY YEYOVOTWV...

Tou tumou LHC dev ewal eva emixelpnpa «puotkne» (Lovo)-ewval EMLXELPNUOA LNXOVIKNG,
NAEKTPOVLKWYV KoL NAEKTPLKWY OXESLACH WYV, UALKWYV (0TEPEQ KATAOTAON), UTTOAOYLOTIKWVY
TIPOYPOUUATWY, OXEOLAOUOU EPOSLACHWY KoL Opyovwong SLotknong, KOTAOKEUNG Kal
opyavwong epyotaélou KTA.

* H «Aettoupyla» (run) tou avixveutn xpelaletal MOAU ELOLKEULEVO TIPOCWTILKO yLa val
LTTOPECEL vaL ELvaL AsttoupyLkog kot va avafaBpuiletatl yia 20-30 xpovia. To ap)Lko
MPOoWTILKO Ba avavewBel, WOLattepa ylatt SEV UTTAPYXOUV «LOVIMES» OEOELC.

e O avi(veUTNC OMWCE KL O ETUTOXUVTING EXEL TIOAU PEYAAUTEPN GUUETOXN QIO TO TIPOCWTTILKO
tou CERN, xwptc BePfata va amokAeLlovtol TOAAEC CUVEPYAOLEG.
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Login/Logout

3rd Quarter ath Quz

Jun

Jul | Aug [ Sep | Oct |

Task Name - |Duration
260 |~ Perform work on YB0+Z with Full acces to vacTank 33.5 days
261 Open YB+2 / YB+1 1.5 days
262 Remove MABs 1day
263 Install access staircase to inside of VacTank 1day
264 Remove CCM jumpers (RBXs) inside VacTank 18 days
265 Remove thermal shield for TK 7 days
266 Install additional services under thermal shield Sdays
267 Install temperature sensors for TK 2 days
268 Perform TK cold test 9days
269 Refurbish Quick connectors 18 days
270 = HO-DT-RPC tasks 20 days
271 = Remove ECAL LV cables 8 days
272 S02M 1day
273 S03 N 1day
274 S06 F 1day
275 S07F 1day
276 511 2 days
277 510 2 days
278 = Remove DT-RPC cables 7 days
279 502503 1day
230 506 507 1day
281 511 1day
282 510 1day
283 = Perform work on HO 10 days
284 502 1lday
285 503 1day
286 506 1day
287 507 1day
288 s10 1day
289 511 1lday
290 = DT chamber extraction for HV repairs 9 days

09/08 T 26/09




Zuotnpoata eEunvwy povwtwy( ~ -20°C kataypadeag tpoxwwv ~ +17°C ECAL)

—

- IK
L
A
S=—a
e " -
b

| IR

\;
VA
N/

‘4’1'||||‘-=




°ZUGCTNHOTO EAEYXOU KLVNOCEWV OVTLKELLEVWV (UTTOOVLXVEUTEG Kal AACL KOpLaTLL
“Tuylouv” pexpL 2 Tovvoug, atodntnpeg)
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We would like to work with you on possible projects that will teach
programming to students, (scratch https://scratch.mit.edu/) in the
context of learning to measure and control numbers; programming
Provided it is done in a way accessible to their age teaches them
the logic and the discipline of going about a measurement

Scratch is used for programming games, playing with photos,
putting together music, etc. | am sure that in this context some of
You might have even used it

We would like to deal with the “Scratch for Arduino-S4A”

version because it gives you the option of combining simple and
visual oriented programming with the Arduino platform that makes electronics
easy and students can make things happen.



https://scratch.mit.edu/

All information about the Arduino platform can be accessed at
https://www.arduino.cc/

From this page you can download the appropriate software, be it
Windows, Linux or Mac OS X (Mac OSX Lion or later). You will not deal
with this software as you will not be an Arduino developer (or you can do it
with some interested students but then you will use C or other “adult”
Programming languages...!)

However, you have to use the Arduino software to tell your system WHAT
Arduino Platform you are using:...you could start Arduino, go to the
menu, select Tools and from there select Boards and click on the

board type you have connected (Uno, Mega, nano, Duemilenove, Leonardo,etc)...

Then, to be sure that you are connected to the board, try to run a
program called “Blink” that makes an LED already built on your
Arduino to “blink” by going to “Menu”, “File”, “Examples”, “Basics”,
“Blink”..


https://www.arduino.cc/

Sketch Tools Help

S4AFirmwared &

7/ MEW IN VERSION l.6c (by Jorge Gomez):
// Fixed variable type in pin structure: pin.state should be int, not hyte
// Optinized speed of execution while receiving data from computer in readSerialPorti(

EERE USRI 6 Blink | Arduino 1.6.11 o (=]
/7 hdded new struc

Fie Edit Sketch | Tooks Help
P This naes

Y7 - Allews to o] Auta Format T

/¢ - Eliminates t Archive Sketch a[pin-4])

/4 - By using an Fix Encoding & Reload el e

/4 Changed all fun Serial Manikor Carl#shift+ ~|FislPort(), wpdateAcruator() and sendUpdatedctuator(]
/¢ Fixed possible Serial Plotter Cirlshift-L ged Eor delagMicroseconds()

/4 Some minor cadi
WiFi101 Firmware Updater

/7 MEW IN VERSION
// Fixed compatibi
/¢ readSerialPort(

Boards Manager .

3 ¥ Ardiino AR Boards

J/ - created stat Pork: "COM?’ » Arduino Vin
7/ - updatehctuar Get Board Info Arduinoftenuin Uno S e I e ct b O a r d t e
7/ Memory use apri F—— ) Arduing Duemlanove or Discii y p
/¢ Cleaning some p & Arduing Mano
Burn Bootloader
7/ hwoid using son 4 Mega or Mega 2560

Arduino Mega ADK
Arduing Leonardo
Arduino/Genuing Micro
Arduing Esplara

7/ MEW IH VERSION
// Refactored rese
// Merged code for
7/ Merged patch £o

4/ the setup function runs once when you press Arduine Mini
d 1=
¢/ WD TH vERsTaw | COLY TR0 Lo Arduino Ethernet
/7 initialize digital pin 13 as an output.
/4 Thanged pin 6 £ 4] Arduino Fio
Arduino BT

/4 MEW TH VERSTON
J/ Changed Serial.

LilyPad Arduino USE
LilyPad Arduino
Arduino Pro or Pro Vi

fible with latest Arduino IDE (1.0}

/7 MEW IN VERSION
/4 Mow it works on
7/ timerz set to 2
#/ readierialport|
7/ pulsei) wodifie JUTY, Arduing Gemma
J/ updateServallators changes 1Ts name as a global variable had Che Sale hame.

/¢ Some minor fixes.

Arduino MG or older
Arduino Robat Control
Arduino Robat Motor

rypedef emm {
input, SErvOmOtOr, pum, digital }

pinType;
typedsf sTruct pin {
pinType type; /#Type of pin
int state; //%tate of an output
sibyte value: /fValue of an imput. Not used by now. TODQ
1:
pin arduinePins[14]: //hrray of struct holding 0-13 pins informacion '_|
>

Arduina Nano, ATme,

i Lepupdt - .. | B husemann.. | ] 2016-082... | € s4aFimow... [&D Blink | Ar... P GCELAEES - »@RIBF Eh sem

tart| © @ (2 GreskTea... | (2 Arduino- matthieur... | | photos oo | B Presentati.. | [ Elineskath.. | &) skype™[... |




&8 Blink | Arduine 1.6.11 [ ==l %
EN

File | Edt Sketch Tooks Help

Blink

0

// the setup function runs once when you press reset or power the board

link program, you can
play by changing the
millisecond numbers

vold setup() {
// initialize digital pin 13 as an output.
pinMode (13, OUTEUT):

ain forever

// the loop function runs over

void loopf() {
digitalWrife
delay (10
digitalWrit,
delay (1000

on (HIGH is the wvoltage level)
ait for a second
// turn the LED off by making the wvoltage LOW
// walt for a second

stat| € @ O GreskTe. |2 ardino-.| | matthieu photos . Sereensh, 3] welcore.... | G resenta... | G Elineskat... | &) Skype™ .. | i Lep.paf -.. | Bl usemen... | =] 2me-te-...| €D saafim... [Boink 1. | 90 TA RED = © U » ® O B[ iy 156 m




All information about the Arduino platform for the Scratch environment
can be accessed at http://s4a.cat/

From this page (Downloads) you can download the appropriate

software, be it for Windows, Linux or Mac OS X (Mac OSX Lion or later).

Make sure that you also get the program that you have to execute in

order to “tell” your Arduino platform that it has to work with Scratch; the
program is found in

“Installing the Firmware into your Arduino”, right-click on “here” and
save target as a .ino and NOT a .htm file as proposed in your

Documents -> Arduino and then run it! You have to do this every time you want

to use Scratch for your Arduino (s)


http://s4a.cat/
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4 Libraries B B B
Installing S4A requires you to install software both in your PC and your Arduino
| Documents »
o) music board. Here you'll find the detailed steps to get it up and running.
] Fictures
B videos < f
Installing S4A into your computer
1 Computer

£, system(c)
9 dfs (ficern.ch) (G:)

58 cmstss (Y\cstssser

€ Nstwork.

Start| € @ (O GreekTea.. |@nrdmnu- .|@s4.n-lnt...

| matthieur... | | photos

S4A works in the three major consumer operating systems. Downloggfnd install
the one that fits your configuration:

+ Windows

- Mac

+ Linux (Debian)

« Linux (Fedora) (version 1.5)

+ Raspbian (Debian for RaspberryPi) (i&
Installing the Firmwargito your Arduino

This firmware is a piece of software you need to install into your Arduino boart
be able to communicate with it from S4A

Download and install the Arduino envirenment by fol
on http:/arduino.cc/en/Main/Software. Take
at least version 0022
Download our firmware from hel®

the instructions
ount Arduino Uno requires

Arduino drivers

Connect your Arduino board to a USB port in your computer :
Open the firmware file (S4AFirmware16.ino) from the Arduino environment
In the Tools menu, select the board version and the serial port where the
board is connected
Load the firmware into your board through File > Upload
v v
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| screenshots |2
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This firmware is a piece of software you need to install into your Arduino board to
be able to communicate with it from S4A
« Download and install the Arduino environment by following the instructions.
on http://arduino.cc/en/Main/Software. Take in account Arduino Uno requires
at least version 0022
+ Download our firmware from here ~
- - 2
L = Connect your Arduino board to a USB port in your computer =
— « Open the firmware file (S4AFirmware16.ino) from the Arduino environment
= In the Tools menu, select the board version and the serial port where the
board is connected
« Load the firmware into your board through File > Upload
Arduino drivers . .
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When you first “read” the Arduino via Scratch, this is what it looks like:
Values that “change”
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There are many types and models of Arduino.

We will be trying to concentrate using the nano Arduino and Uno
which we will use for all the projects we propose to you. Using the
Arduino in the Scratch environment you can read “analog”

sensors and digital “sensors”.

Sensors are a huge industrial/scientific

explosion of our times and CERN is a remarkable sensor
consumer/producer.

Sensors provide information about everything and can be read in an
analog way like current, voltage, resistance and many others (favour
these for learning) or they can be digital and have an integrated
microprocessor that gives you directly the numerical measured
value.



The analog sensors you can read in Scratch are attached to your
Arduino platform (literally)

* Thermometers

* Light level (photo resistors)

* Humidity

* Flow

* Pressure

* and many others ....

the numerical measured value.
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Basedonscratch @b [ File Edit Help

Motion Control

E‘ Arduinol
Looks Sensing B

Sound Operators

Pen Variables

[Ed ‘light

set light [to [{ se: light |to value of sensor Analogl
change light |by
show variable light
hide variable light

Make a list

Failed to open MIDI output device Microsoft MIDI Mapper:
'There is no driver installed on your system.
Failed to open MIDI output device Microsoft MIDI Mapper:
'There is no driver installed on your system.
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The digital sensor connections ; powering and D3 as output
for a temperature sensor, DS18B20 (+125 to -55°C)
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Each sensor requires
two separate Arduino
Analog Inputs to be
read out (T - yellow
and RH - blue wires).
The Arduino Nano has
eight Analog Inputs, AO

In a cabled system, we
would need at least
two lines for powering
the sensors (VCC and
GND) plus two lines
per sensor for the two
analog outputs, better

yet four lines (analog

Kootoc ~30 supw
output plus extra GND)

to A7, so we can read
four HS-2000 sensors

LIRS . . o e ®© © 00 0 0 0 0 000 0000000 0 00
o . . o ® © 90 0 0 0 0 0 000 0 00 0 0 00 0 00
¢ . . ° o ® © 90 0 0 00 00 000 00 00 0 00 00
. L o e ® 0 0 0 000 0000000000000 00
- - o ~ ® 0 00 0 0 00 000 000 00 0 0 0 00
LI . ® © 00 0 0 00 0 000000000000
® o 0 . ® © 0 0 00 0 0 00 0 000 0 0 0 0 0 e
° o 0 . ®© © 0 00 0 0 0 0 00 00000 0 0 0 000
e o 0 . ® © 0 00 00 0 0 0000000 00 0 00
° o 0 . ® © 0 00 0 00 0 000000000000
. ° . ° LR LR 0o 0 0 0 e 0 00
. o LR LR ] LR ] o 0 00 o 0 0 0
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HS-2000 Temp and RH
Analog Output sensor

Tout VCC RHout GND

fritzing
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